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1. Introduction FriemCom 

 

1.2 - FriemCom 

 

FriemCom program is a Windows-based communication program developed by Friem.  

 

2. Technical support 

 

For technical support on the installation of FriemCom, for questions about the program, to request program or 

database upgrades, or to request the addition of new devices to the database, visit the FriemCom Support Site 

located on the World Wide Web :  www.friem.com 

Or, contact: 

 

  

 FRIEM S.p.A. Via Edison, 1 - 20090 SEGRATE - Milano (MI) - Italy 

Tel: +39 022133341 - Fax: +39 0226923036 - info@friem.com 

 

   

3. Hardware and Software requirements 

 

3.1 - Hardware requirements  

 

Hardware requirements :  

• PC with Pentium3 processor or newest; 

• At least 256 MByte di RAM (recommend at least 512 MB on WinXP systems); 

• At least 200 MByte free on hard disk; 

• Graphical resolution at least 800x600 with 256 color (recommend 1024x768 or more); 

• Keyboard and mouse. 

Serial interface requirements : 

The interface used for connection is RS-485 (half-duplex), which allows to connect in parallel up to 31 units. 

The communication bus can be long up to and over 1000m if shielded twisted pairs of cable are used for 

connection. Using a simple twisted pair the recommended length is reduced to 500 m. Using a fiber optic 

transmission, up to 200 units can be connected on the same bus with distance up to 3 Km between units (glass 

fibre optic). 

 

 

 

 

mailto:info@friem.com
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An RS232/485 adapter is needed to use one of the serial ports available on the personal computer for the relay 

management. 

Friem 232/485 converter automatically recognizes the data flow so no configuration is needed. 

The use of a P.C. serial port fitted with a UART type 16550 is recommended; normally high speed serial ports 

(baud rate over 9600bps) use that component. 

 

 

3.2 - Software requirements 

 

Microsoft Windows operating systems : Microsoft Windows 98SE, ME, 2000(SP3),XP(SP1). 

 

Installation: 

Insert FriemCom installation CD-ROM. 

If automatic startup don’t start, open the CDROM directory and execute the “Setup.exe” file. 

Follow installation instructions.  
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4. Getting started 

 

4.01 - Getting started 

 

The FriemCom main screen is in the classic windows system format. Each connected relay will open a new 

window in the main window. 

 

 

 

As you can see the program can support more languages, to select desired language open “Language” menu and 

select the language. 
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4.02 - Basics 

 

After started FriemCom, you can connect to relay in on line or off line mode. 

 

 

 

The “Search on serial port” window, must be used when you want to connect to the relay through a serial port, real 

or virtual. 

FriemCom can open more than one relay at the same time. You can open more instance of the same relay. 

The last relay you have selected is the Active Relay. To change the active relay select another relay or variable. 

Each relay is inside a window with more buttons, the buttons refer only to that relay, instead the application menu 

are generics for all the program. 

NOTE: the modem connection is available only in the registered program version.
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All relays connected can communicate in 2 mode : 

Read Only  . 

Read / Write  . 

 

In the read only mode you can see all data of all windows (Measures, Events, Settings, inputs and outputs status, 

Commands), but when you try to send data to relay FriemCom will ask you the Password to enable write, than if 

all ok will change to Read / Write mode. 

In Read/Write status all windows functions are available. 

 

4.03 - How to connect to relay 

 

After program start it’s possible to open a relay OnLine or OffLine (with communication ON or OFF).  

To connect to relay be sure of correct wire connection with the communication cable, than select “Search” menu 

and select “On serial port” option. 

Select the communication COM port (it will appear only the COM ports available) and the baud rate (default is 

9600 for Compact).  

Click on “Scan” button to display the relays available and respective communication node address. 

Select in the list desired relay, if you want to stop search click on “stop” button. 

Click on the “Connect” button to connect to the relay. 

Click on “Cancel” button to close the “Search on serial port” window. 

NOTE: during the relay creation you must wait that all data will be created, a few seconds. 

To connect to relay OFF line (without communication) select from the “File” menu the “New” option. 

NOTE2: To connect a relay through MODEM please refers to paragraph 5.3. 

 

4.04 - How to select the language 

 

FriemCom support more languages, to select the desired language select the “Language” menu and select the 

option referred to the language. 

NOTE1: default language is English, if you change language the program will save the option for the next time. 

NOTE2 : The FriemCom language change in real time if you select a language, but if you have already open a 

relay it will not change language until you close and reopen the relay. The relay language is hold and kept at a 

moment of the creation. 
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4.05 - How to display data  

 

After relay connection FriemCom will be display the first available data window associated to relay. 

To display the list of available data group (ex: measures, events, settings, status, inputs, outputs, commands  ...) 

click on “Menu” button and choose the option for change window or open new window, or click the left mouse 

button over the relay icon displayed near the the icons on the main window. 

 

 

 

 

If the variable data is not fully displayed you can scroll with the “scroll bars” displayed automatically. 
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Some data groups are displayed like “tree view” (ex: functions, setting for inputs or outputs ... ), you can extend 

and compress data through “+” and “-” of the root lines, like the classic “Resources Manager” window. 

 

 

 

The “Functions settings” window of Compact series does not update the relay automatically. 

You can modify parameters and send them all together to the relay selecting “Send” button,  

otherwise to read the parameters from the relay select the “Read” button.  

After that a send command is issued the data are automatically read from the relay. 

NOTE: reading parameters from the relay override all the parameters setting on the PC. 
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4.06 - How to modify a parameter : 

 

After a relay connection are available all data shared from the relay. 

To modify a value select it and click the right button mouse. FriemCom will display a window with some 

information, and if the data can be modified will display a section to change the value parameter, otherwise the 

section for change will be displayed empty. 

 

The “Functions settings” window of Compact series does not update the relay automatically. 

You can modify parameters and send them all together to the relay selecting “Send” button,  

otherwise to read the parameters from the relay select the “Read” button.  

After that a send command is issued the data are automatically read from the relay. 

NOTE: reading parameters from the relay override all the parameters setting on the PC. 

NOTE1: to send the date to relay you can select it from the group “Date” or in the group “System settings”, select 

the date parameter and click the right mouse button, answering yes, the FriemCom will send to the relay the 

actual date and time present on the PC. 

NOTE2: to send a command (example from the commands group) click on the right mouse button on the desired 

command, than answering yes to the request of send command, FriemCom will send the command to the relay. 

NOTE3: if the device is on-line and some values are displayed with colour different from the default it means that 

parameters are not updated (are not written in the device), to make up to date you must select the "send" button 

and wait the end of write operation. If the device is not on line the modify of the parameters don't make different 

colour because that parameters are only in the PC memory. 
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4.07 - Save relay settings  

 

When relay is connected select with right button mouse on desired icon relay, select “Save on File” option and 

chose the file name for saving. 

 

 

It is possible to save it also from the relay option in the main menu, like the follow picture : 

 

 

 

After select the "Save on file" option. 

 

NOTE : It’s better to save a relay configuration when the relay is “Connected” (On Line) instead created off line, 

because in the saving procedure the values data are consistent with the real relay data, otherwise the values data 

created off line are at the minimum or empty value. 
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4.08 - Open a saved relay configuration file 

 

Select from the “File” menu the “Open” option, select the desired file to load. 

 

4.09 - Export data in text format 

 

The “Export” function allow to copy all parameters of selected group in the “Clipboard”. For example if you want to 

export all physical inputs parameters in a text file : connect to relay, select physical inputs group, click on the 

"Menu" button and after “Export” button. Now the parameters are available to “paste” in a text file, Word file, Excel 

files, ready to import in an Access table, ..... the saved format is text separated with tabulation characters. 

 

 

 

NOTE: function available in registered program version. 
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4.10 - Print parameters 

 

Are available 2 kind of printing : the first type “Actual show” is exactly the same portion displayed on the screen, 

the second type “All variables” is the print of a list of all parameters of one group, the selected group (for example 

all actual measurements). 

To print click on "Menu" button and then select “Print” option after select the print modality. 
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5. General Overview 

 

FriemCom program update windows data automatically every second, if you send a parameter value (for examples 

a function timer) the change in the relay is in real time, after you can see in the window parameter the modified 

value. If the relay is not on line is set to read/write and you can modify parameters for the off line configuration. 

FriemCom include a communication manager that allow you to communicate to relays on more serial COM port at 

the same time. 

5.1 - Menu bar 

 

5.1.1 - File menu 

 

With the “File” menu you can create a new off line relay (New) or load a configuration relay previously saved 

(Open).  
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5.1.2 - Tools 

 

In the “Tools” menu you can select the “Graphic” option, it allow you to load a Plug-in and display the 

oscillographic curves of oscillographic recorders. 

The “Firmware upgrade” option allow you to update the application inside the relay (firmware application) for 

relays that support this features. 

 

 

 

 

 

NOTE : the graphic dysplay of graphics directly from FriemCom is available only for registered program version. 
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5.1.2.1 - MSGraphic 

 

MSGraphic is a FriemCom additional tool displaying in graphical way the oscillographic data. 
To see the graphic, select an event and the function (in the example “I1”) and click the button “Show selected 
curves”.  
Here below a “possible” result: 
  

 

 

 

After some seconds the data will be loaded and you will be able to perform some operations using the 
MSGraphic features: 
You can resize the window, the graphics scale will be arranged automatically 
To delete all the displayed data push the “Clear” button. 
To display the configuration window or to use the mathematical functions push the Options button. 
The Print button prints the window graphic area . The standard print configuration features are available. 
To load the file, in excel format, push the Load button. 
To save the graphic in .bmp or .wmf format, push Save button. 
The Close button hides MSGraphic without deleting the graphic data representation until the closure of 
FriemCom or the pressure of Clear button 
A zoom feature is available: select the left up corner of the area you want to display and drag the mouse cursor 
up to the right bottom corner. The displayed area will be the selected area as you release the mouse button. To 
reset the zoom factor redo the same operation but from the right bottom corner to the left up corner. 
To display other data change the selection in the Oscillographic data section and select push the 
“Show selected curves” button. Another way to add new curves is to perform graphical operations on the 
already 
displayed curves. 
 

 

 

WARNING : MSGraphic can display more graphics at the same time, but it can be difficult to see everything, we 

suggest to display a max of 10 curves at the same time. 

“MSGraphic Configuration” window displays four different options: 
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“Points and Values” option allows you to display the graphic of the selected curve and the values of the 

oscillographic records at the same time; it’s also possible to delete the selected curve. 

The “Change color”  allow you to change color of selected curve. 

 

 

 

 

The “Traslation” page allow you to move the selected curve by an offset of  X and Y, both positive and negative 

for each selection of “Apply” button.  
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“Calculate New Curve” option allows you to perform graphical operations on the selected curves so as to add 

new curves. 

The available options are: 

Legend: you can assign to the calculated curve a new name; the default name is “Calculated”. 

Source1 and Source 2: these radio button group boxes allow to select the curves from which you calculate the 

new curve. 

Operation: this combo box allows to select the mathematical operator. 

The Calculate button draws the new curve and closes the window. 

Warning: the points of both curves involved in the mathematical transformation MUST have the same x 

coordinates. 

 

 

 

“General Options” window allows you to set the number of points for graphics and to display the curves in 3D 

(this option is very useful when the curves are superimposed) 
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5.1.2.2 - Firmware upgrade 

 

The firmware upgrade allow you update the software application or the monitor application inside the relay. 

NOTE 1: to be sure to do a correct execution, before the firmware or monitor upgrade, it’s better to avoid other 

communications, otherwise it can be display a communication error or COM port not free. 

To enter in the firmware upgrade function, execute FriemCom program, select the “Firmware upgrade” option in 

the  “Tools” menu. 

 

 

Select communication COM port; select “Upg. firmware” or ”Upg. monitor”; click on “XXX serie upload” and 

select the upgrade file to upload. 

NOTE 1: DON’T select the “First time” option, it is used only at first upgrade in factory or in exceptional 

emergency. 

NOTE 2: Both firmware upgrade and monitor upgrade have extension “.S” or “.SRec”. It’s prohibited to upgrade 

firmware or monitor with a wrong file, be sure of file you are using. 
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After file selection will display a progress bar to show the progress status, when the progress bar ends you must 

wait the finishing of operations. 

While the relay work the information you can see messages on text list. 

When the upgrade ends will display a message for operation completed, if the relay support the automatic 

restart, the command will be send automatically and the relay will be restarted. 

NOTE 4: after upload if the relay found an error will be displayed a further message, it inform you of an error 

presence, the operation may be terminated not successfully, to check the error message control the messages 

relay text list. 

NOTE 5: if there are errors in the update operation for firmware or monitor the relay will restart with the previous 

application or monitor version. 

NOTE 6: if the automatic restart doesn’t work it’s possible to restart the relay living power supply for a few 

seconds. 

NOTE 7: if available “Default setup” you can send to relay the restoration of setting factory.  

WE STRONGLY SUGGEST YOU to send this command after any firmware update. 

WARNING : sending this command the previous settings will be lost and the default settings will be ready. 
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5.1.2.3 - Network synchronization 

 

The network synchronization allow to update and synchronize the date and time in the relays of the “Compact” 

series. 

 

 

 

Independently from the relays models this function allow to synchronize date and time on one serial COM with a 

polling from 5 to 60 minutes. 

NOTE : IT's important all relays on the serial COM port selected have the same baud rate otherwise the relays 

with no equal baud rate will be not updated. 

NOTE 2 : The Line M line relays must be set with the "TSync" parameter disabled. 

NOTE 3 : If the network synchronization window is not visible bus it was been activated, the program will send 

in background the synchronization at the end of the polling time. 

NOTE 4 : The network synchronization is available only for the program registered version. 
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5.1.2.4 - Sounds Configuration for alarms 

 

The sounds configuration function allow to execute a sound when there is a condition verified. 

NOTE : The sounds configuration is available only for the program registered version. 

 

 

The sounds configuration can be used for the “Compact” series parameters, for now the window compatible are 

: physical inputs, logical inputs, logical outputs and physical outputs. 

To add a parameter to configuration list you must click with right button mouse on the parameter (if the 

configuration option is enabled it is possible to add the parameter) and select "Sounds configuration". 

To display the sounds configuration for alarms select the "Sounds configuration" in the "tools" menu. 

In the configuration windows are display the parameters status, the main information for alarms conditions and 

the last status of last alarms registered. 

NOTE 2 : the data windows where parameters are taken MUST REMAIN OPENED IN COMMUNICATION 

otherwise the parameters in the sounds configuration will be not updated.  

To modify the configuration alarm condition select with right mouse button or double click with the left mouse 

button to enter in the alarm configuration window. 
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For the condition type you can  :  

To assign a user name to identify the parameter (Mnemonic name), 

To assign the condition type : not equal to, greater of, smaller of, equal to. 

To choose the condition type for a number or for a string, 

To choose the working type : One time and no more, one time every time the condition is verified (after the fall of 

the condition) or continuous working, 

To choose the sounds when the condition is verificated (".wav" or ".mid" type files). 

Select the "Ok" button the condition are fixed otherwise select cancel to loose the modifications. 

The "Stay on top" option if checked it makes the window on top of the other windows.    
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5.1.2.5 - Preferences  

 

This option allow to modify the properties of program execution. 

 

NOTE : this parameters are saved when the program is closed and they are reload when the program start. 

 

Example : 

 

- background color in windows : it is possible associate a background color for all the data windows who show 

the data in a table mode, the function window for his particular working is not modifiable. 

 

- auto-resize the width of the fields : this property modify continuously the fields dimensions of the parameters 

values of the relays to show better the information. If this option is disabled it will be done only one update on 

the window creation and than the dimensions are modifiable manually. 
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5.1.3 - Relay Options 

 

In "Relay options" menu is shows the relays list on line. 

After the relay selection from the list, it will display a new window with the options linked to relay (like save, 

connect OnLine or OffLine, the relay close, etc.) and another list of data windows available. 

The choice of the option or the window data can be done by a double click on the left button mouse, or selecting 

the icon with the cursor keys and "TAB" key, and confirm with "SPACE" or "ENTER" key.   
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5.1.3.1 - Compare  

 

This function allow you to compare the relay values with another relay displaying the differences. 

Obviously the relay models must be the same. 

 

NOTE : if a relay is created or opened off-line will be asked to communicate with the second relay, otherwise if 

the relay is under communication will be asked to load a configuration file. 

 

 

 

When the compare is done if you select a row of the relay value on high side (the first) will be highlight the 

respective row of the other relay, it is to see more fast the difference. 

 

NOTE 2 : the first time the compare window is showed will be automatically select the "Compare" button, the 

next showing will display the previous data, if you want another compare select again the "Compare" button. 
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5.1.3.2 - Settings export  

 

This function allow to export the settings from a relay model to another relay model. This operation is executed 

through comparison on settings compatible layer, if they are compatibles the data will be exported, otherwise 

the data will be empty. 

 

NOTE : it is possible to export only from “Compact” line models to “Compact” line models. 

 

 

 

After export operation it is important to pay attention on exported values particularly on the input-output 

configuration side. In case the export procedure don't find the identical logical output (or logical input for the 

inputs) can happen an double association on the first output function (or input function). 

After check the exported values and insert the empty values you have a new off-line relay available that can be 

saved to file or ready for an "Settings Upload" in the new relay model. 
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5.1.4 - Help 

 

In the option menu are present the following option : 

Diagnostic option display communication diagnostic of FriemCom COM ports used. 

Registration option allow you to enable all the program functions. To register the program you must send the 

“installation code” to the factory local supplier, then you can insert the unlock code to enable registration and use 

all the options. When the registration was done, it will be active for the actual operation system. In the not 

registered version are enabled only the load and save relay functions, the print and the firmware update, all other 

functions are disabled. 

NOTE: we suggest to restart the program to enable all the functions after registration. 

About option display FriemCom about window with the version information. 
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5.3 - Connection through MODEM 

 

To enable a connection through modem select the option “On serial port” in the “Search” menu. 

NOTE 1: function enabled only in the registered version of the program. 

NOTE 2: to connect trough modem you need a second modem to remote relay already configured for auto 

answer and to be connected to the relays. 

Before begin to search the relays you must setup modem selecting “setup modem” button, it will be read the  

“modem.ini” file who contains the AT commands to setup the calling modem. “Modem.ini” file is in the main 

program directory, and you can modified it in order to work properly on you modem model. 

NOTE 3: The “modem.ini” file is a common text file, each row is a command, it’s possible to skip a command 

append on the first character of the row one “;”. Warning, if you update the program the file will be rewrite with the 

installation file. 

For each AT command sent to modem there is a control, if there is an error will be display the command and the 

modem response, each modem may have values or commands different, refers to the model manual if there is 

errors, in any case you can to continue after an error.  

After modem setup you can insert the telephone number to call, if the call is terminated correctly will display a 

message of correct connection, now the communication is ready for the relays, do the scan to display the 

available relays. 

NOTE 4: at the end of operations, also closing the program, the modem connection will not be automatically 

close; to close the modem connection select “Disconnect modem” button or turn off the modem. 

NOTE 5: Firmware update is not permitted, the modem connection don’t has enough speed.  
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In the table below there are examples of AT commands you can find : 

Function Robotics 

56k Fax 

Modem 

Generic 

Modem with 

Rockwell 

chipset 

Robotics 

Flash x2 

Trust 

AE/AC 

1414 

BOCA 

Modem 

Select string on errors return DCE->DTE  ( V0 = 

Number, V1 = Strings) 

V1 V1 V1 V1 V1 

Only for modem connect to PC, no auto answer s0=0 s0=0 s0=0 s0=0 s0=0 

Only for modem connect to relays, auto answer s0=2 s0=2 s0=2 s0=2 s0=2 

Disable Volume M0 M0 M0 M0 M0 

Phone number compose type  

(T = Tone, P = Pulse )   

T T T T T 

Speed from DTE->DCE e  

DCE->DCE fixed on 9600 baud with V32 or 

V32bis modulation 

&U6 

&N6 

&B1 

&U6 

&N6 

&B1 

&U6 

&N6 

&B1 

N0 

S37=9 

N0 

S37=9 

Standard Modulation   

( B0 = CCITT , B1 = BELL) 

B0 B0 B0 B0  

Compress data disabled. &K0 &K0 &K0 %C0 %C0 

Errors correction disabled. &M0 

S15=136 

&M0 

S15=136 

&M0 

S15=136 

\N0 \N1 

DCD state of line carrier detect (enabled). &C1 &C1 &C1 &C1 &C1 

Flux control RTS/CTS disabled. &R1 

&I0 

&H0 

&R1 

&I0 

&H0 

&R1 

&I0 

&H0 

&R1 

&K0 

&K0 

DTR close communication. &D2 &D2 &D2 &D2 

&Q0 

&D2 

Detect central tone disabled and select the 

return codes from modem. 

X0 

Q0 

X0 

Q0 

X0 

Q0 

X0 

Q0 

X0 

Q0 

Select configuration for the startup modem (0 

profile of internal NVRAM memory) 

&Y0 

 

&Y0 

 

&Y0 

 

&Y0 &Y0 

Save current configuration like configuration 0 &W0 

 

&W0 

 

&W0 

 

&W0 &W0 

X2 function disable  - 

 

- 

 

S32=32 

S58=4 

-  

 

 



 FriemCom Doc. N° MO-0337-ING 
 

Copyright 2007 Data 27.09.2007 Rev. 0  Pag. 31 di 33 
 

 

The modem connection to relay can be done in 2 way, if you connect on the front port of the relay (if available) the 

connection is peer to peer and you can communicate with only one relay at a time, if you connect on the back port 

of the relay (RS485), you can communicate with more relays but you need a RS232/RS485 converter more, in all 

cases you need a special cable, as displayed in the following drawing: 

 

 

 

In the table below you can find the correspondence between the input and output pin of the special cable 

connecting modem and converter or relay. 

 

 

INPUTS (from modem) OUTPUTS (to converter) 

1 – DCD 1 – DCD 

2 – RD 3 – TX 

3 – TD 2 – RX 

4 – DTR 4 – DTR 

5 – GND 5 – GND 

6 – DSR 6 – DSR 

7 – RTS 7 – RTS 

8 – CTS 8 – CTS 

9 – RI 9 - RI 
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5.4 - How to save and restore the relay settings 

 

When a relay is connected, select with the right button mouse on the relay icon, or select the relay from the 

"Relay options" menu and select the “Save on file” option. 

 

NOTE : It’s better to save a relay configuration when the relay is “Connected” (On Line) instead created off line, 

because in the saving procedure the values data are consistent with the real relay data, otherwise the values data 

created off line are at the minimum or empty values. 

 

Now the relay configuration is saved, now is possible to change parameters for tests, when you finish the tests 

and you want to restore the previous configuration from file, you must do the follow operations. 

close the relay or not consider the relay online actually in use. 

open the configuration saved on file. 

EVER remain OffLine you must select the "Upload settings" option. 

 

"Upload settings" option can be select with the right button mouse on the relay icon, or select the relay from the 

"Relay options" window in the "Relay options" menu. 

 

the program ask for communication parameters (insert correctly data or communication doesn't work). 

at the end choose for connect to the relay or remain OffLine. 

 

NOTE : in the "Upload settings" procedure there are parameters not updateable, this parameters are : the relay 

password, serial number, relay description. 
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5.5 - How to Export an oscillographic registration in COMTREAD files format 

 

Connecting a relay of “Compact” series and opening the oscillographic registration window is now present a new 

button "Exp. COMTRADE", like follow picture. 

 

 

 

To export the COMTRADE compatible files you must select the desire record and select the button 

"Exp.COMTRADE". 

 

NOTE : the button will be display and the procedure will be executed only for registered program versions. 

 

 




